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Performing Basic 
Calculations 
After completing this lesson, you will be able to: 

� Build formulas. 

� Copy formulas. 

� Edit formulas. 

� Use the SUM function and AutoSum. 

� Use the Insert Function feature. 

� Use Date functions. 

� Use absolute and relative cell references. 

� Use basic statistical functions. 

� Use numbered series and AutoFill. 

With Microsoft Excel, it’s easy to perform common calculations. In addition to 

adding, subtracting, multiplying, and dividing, you can calculate the total and 

compute the average of a set of values. With basic calculations, you can figure 

profit values from revenue and expenses, or you can compute an employee’s 

wages from hours worked and pay rates. These are just a few examples of the 

calculations Excel can perform. 

At the Adventure Works resort, the reservations manager is preparing a report 

on annual vacancy rates. To start, he finds the total number of nights that each 

type of room was occupied. Then he calculates the average number of rooms 

occupied per night. Finally, he figures the occupancy rate for each type of 

room. The results of these calculations will help him plan the upcoming season 

and schedule cabin renovations for the time of year when demand is lowest. 

Also at Adventure Works, the accountant is calculating income generated from 

equipment rentals for various activities. With those numbers, he can compute 

the average income earned from each activity each month. The activities 

coordinator will use these figures to plan her strategy for activities in the next 

year. 

In this lesson, you learn how to perform basic Excel calculations with formulas 

and functions. You learn how to create and edit formulas, use mathematical 

operators, and use Excel’s built-in functions. 

To complete the procedures in this lesson, you will need to use the files 

Lodging Usage.xls and Activity Rentals.xls in the Part IV, Lesson03 folder in 

the Computer Fundamentals Practice folder located on your hard disk. 

LESSON 3 
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Building Formulas 

A formula is the written expression of a calculation to be performed by Excel. 

When you enter a formula into a cell, the formula is stored internally while the 

calculated result appears in the cell. 

A formula is a mathematical equation consisting of two elements: operands and 

mathematical operators. The operands identify the values to be used in the 

calculation. An operand can be a constant value, another formula, or a 

reference to a cell or range of cells. Mathematical operators specify what 

calculations are to be performed with the values. 

To allow Excel to distinguish formulas from data, all formulas begin with an 

equal sign (=) or a plus sign (+). To view a formula, click the cell containing 

the formula. The formula will appear in the Formula bar. 

You can use any of the following mathematical operators in a formula. 

Operator Meaning 

^ Exponentiation 

* Multiplication 

/ Division 

+ Addition 

- Subtraction 

When a formula contains two or more operators, operations are not necessarily 

performed in the order in which you read the formula—that is, left to right. The 

order in which operations are performed is determined by operator priority, as 

defined by the rules of mathematics. For example, exponentiation is always 

performed before any other operation. Multiplication and division are next on 

the priority list, performed sequentially from left to right. Finally, addition and 

subtraction are performed, again from left to right. Consider the following 

equation. 

2 + 4 * 6 / 3 - 1 = 9 

First, four is multiplied by six, and the result is divided by three. Two is then 

added to the result, and one is subtracted. 

Operations contained within parentheses are completed before those outside 

parentheses. You can override the standard operator priorities by using 

parentheses. Thus, the following equation is calculated differently than the 

previous one. 

(2 + 4) * 6 / (3 - 1) = 18 

In this formula, two and four are added first, and the result is multiplied by six. 

Finally, that result is divided by the result of three minus one. 
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Creating a formula is similar to entering text and numbers in cells. To begin, 

you select the cell in which you want the formula to appear. Then you can use 

one of two methods to create the formula. 

In the first method, you type the formula, including cell addresses, constant 

values, and mathematical operators, directly into the cell. To mark the entry as 

a formula, you start by typing an equal sign. 

In the second method, you paste the references for a cell or range of cells in the 

Formula bar. You then complete the formula by typing any operators, constant 

values, or parentheses. 

As you build a formula, it appears in the Formula bar and the cell itself. When 

you have completed the formula, the cell displays the result of the formula, and 

the Formula bar displays the formula itself. 

The reservations manager at Adventure Works has tracked the number of 

nights each type of room was occupied in each month for the last year. To 

calculate occupancy rates, he must find the total number of nights occupied for 

each month, divide that total by the number of rooms, and finally divide that 

result by the number of nights in the month. 

In this exercise, you open a worksheet and create basic formulas in the 

worksheet. 

1 Open the Lodging Usage workbook from the Part IV, Lesson03 

folder in the Computer Fundamentals Practice folder. 

2 Click cell C9, type =C5+C6+C7. 

As you type each cell reference, the cell being referred to is 

selected and the selection border appears in a specific color. This 

color matches the color of the text used for the cell reference. 

3 Press Enter. 

The total of the cells (908) appears in cell C9. 

4 Click cell C13, type =, and then click cell C5. 

C5 is added to the formula. The cell you click is color-coded and 

shows a flashing marquee border. 

5 Type /, click cell A5, and then click the Enter button on the Formula 

bar. 

Excel completes the formula and displays the ratio of cells C5 and 

A5 (30.25). 

6 Scroll down, if necessary, and click cell C21. Click in the Formula 

bar, type =C13/31, and then click the Enter button on the Formula 

bar. 

Excel calculates the occupancy rate of chalet rooms for the month 

of January (0.97581), and the results appear in cell C21. 

7 On the Format menu, click Cells. 

8 Switch to the Number tab if necessary and click Percentage on the 

Category list. 

When you type a cell address 

in a formula, it doesn’t matter 

if you use uppercase or 

lowercase letters. For 

example, references B8 and 

b8 refer to the same cell. 
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9 Click OK to accept the default number of decimal places (2). 

The value in C21 appears as a percentage. 

 

Keep this file open for the next exercise. 

tip 

By default, Excel calculates formulas automatically. To change when a 

formula is calculated, on the Tools menu, click Options, and on the 

Calculation tab, select the desired option. 

Copying Formulas 

You might often find that a similar formula is needed in several adjacent cells. 

For example, if you have a list of items and each item contributes to the total 

income for one year, you might want to add the items to total the income for 

that year. To total the income for consecutive years, you can create formulas to 

sum the income for each year. 

Fortunately, you can avoid entering formulas repeatedly and save a 

considerable amount of time by copying a cell with a completed function and 

pasting it into the destination cells. You can also use the Fill handle, which is 

the small square in the bottom-right corner of the active cell. 

 

When you select a cell with a formula and drag the Fill handle, Excel changes 

the cell references in the formula to match those of the column or row to which 

it has been copied. 

The reservations manager does not want to type the same formula over and 

over to calculate the occupancy rate for each type of room for each month. 

Instead, he copies his formulas to several locations. 

To calculate the formulas in 

all worksheets in all open 

workbooks, press F9. To 

calculate those in only the 

active worksheet, press 

Shift+F9. 
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In this exercise, you copy formulas in your worksheet. 

1 Click cell C13, and on the Edit menu, click Copy. 

A flashing marquee border appears around the cell. 

2 Click cell C14, and on the Edit menu, click Paste. 

The formula is pasted in cell C14 and the Paste Options button 

appears next to the cell. 

3 Repeat step 2 for cells C15 and C16. 

4 Click cell C9, and point to the Fill handle. 

 
The mouse pointer turns into a crosshair pointer when properly 

positioned. 

5 Drag the Fill handle to cell D9. 

The formula in cell C9 is copied to cell D9 and the Auto Fill Options 

button appears next to the cell. 

6 Click cell D9, and observe its formula in the Formula bar. 

The formula is copied from C9, and the column letter is adjusted to 

match the column of the new cell. 

7 Point to the Fill handle in cell D9, and drag the handle to cell N9. 

The formula is copied to cells E9:N9. The total numbers of nights 

occupied for each month are displayed in cells E9:N9. 

 

8 Save the worksheet and leave it open for a later exercise. 

For more information on the 

Paste Options button, see 

Lesson 2 “Editing and 

Formatting Worksheets.” 

To copy a formula from the 

cell to the left of a selected 

cell, press Ctrl+R. To copy a 

formula from the cell above a 

selected cell, press Ctrl+D. 

When you copy a formula to 

a different cell, Excel also 

copies the formatting to the 

other cell. 

You can use the Fill handle to 

copy text directly from one 

cell or another, or you can 

use it to complete a series of 

years, dates, days, and so 

on. You will learn more about 

Fill features later in this 

lesson. 
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Editing Formulas 

Editing a formula that you have already created is easy and similar to editing 

the contents of any other cell. You can: 

■ Double-click the cell, type your changes directly in the cell, and 

press Enter. 

Or 

■ Click the cell, click in the Formula bar, type your changes, and click 

the Enter button on the Formula bar. 

To delete a formula, click the cell and press the Delete key. 

In this exercise, you revise and delete formulas. 

1 Open the Activity Rentals workbook from the Part IV, Lesson03 

folder in the Computer Fundamentals Practice folder. 

2 Click cell O3, and click to the right of the formula in the Formula 

bar. 

The insertion point flashes at the end of the formula. 

3 Press the Backspace key three times, then click the Enter button. 

The price per rental, shown in cell O3, is deleted from the formula. 

The revised formula calculates total kayak rentals for the year. 

4 Copy the formula to cells O4:O17 by using the Fill handle in cell 

O3. 

Excel calculates and displays the total yearly rentals per type of 

equipment. 

5 Click cell O2, delete the existing text, type Yearly Rentals, and 

then press Enter. 

The new label replaces the old one. 

 

6 Click cell O17, and press the Delete key. 

The formula and the cell contents are deleted from the cell. 

7 Close the workbook without saving your changes. 

If you inadvertently delete or 

change a formula, press 

Ctrl+Z or click the Undo 

button on the Standard 

toolbar to reverse the action. 
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Using the SUM Function and AutoSum 

One of the most common calculations performed in a worksheet is adding a 

range of cells. You can add a range of cells by creating a formula that includes 

each cell label separated by the addition (+) operator. An easier way to achieve 

the same result is to use the SUM function. 

A function is a predefined formula that performs a common or complex 

calculation. A function consists of two components: the function name and, in 

most cases, an argument list. The argument list, which is enclosed in 

parentheses, contains the data that the function requires to produce the result. 

Depending on the function, an argument can be a constant value, a single-cell 

reference, a range of cells, a range name, or even another function. When a 

function contains multiple arguments, the arguments are separated by commas. 

For example, the SUM function adds values or a range of cells. You enter the 

range of cells as an argument to the function, and Excel calculates the total of 

the range. A typical SUM function, totaling cells B5 through B10, looks like 

this. 

 =SUM(B5:B10) 

You will learn about other functions later in this lesson. 

Excel’s AutoSum feature offers a shortcut for entering SUM functions to total 

ranges of cells. When you click the AutoSum button on the Standard toolbar, 

Excel totals cells directly above or to the left of the cell containing the function. 

The reservations manager learns that AutoSum can make it even easier for him 

to complete his occupancy calculations. He can use AutoSum to calculate the 

many totals he needs. 

In this exercise, you use AutoSum to total a range of cells. 

1 If necessary, switch to the Lodging Usage workbook that you used 

earlier in this lesson. 

2 Click cell C17, and click the AutoSum button on the Standard 

toolbar. 

A SUM formula appears in cell C17 and the Formula bar, and the 

range C13:C16 is surrounded by a flashing marquee border. 

3 Press Enter. 

The formula is entered in cell C18, and the result (54.15) is 

displayed. 

4 Click cell O5, and then click AutoSum. 

A SUM formula is displayed in cell O5 and in the Formula bar, and 

the range C5:N5 is surrounded by a flashing marquee border. 

If there are any nonnumeric 

cells within the range of cells 

you want to total, AutoSum 

will, by default, calculate the 

total only from the active cell 

to the first nonnumeric cell. 

To get around this problem, 

either alter the arguments to 

include the full range of cells, 

or select only the range of 

cells you want to total. 
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5 Press Enter. 

The formula is entered in cell O5, and the result (2908) is 

displayed. 

 

6 Save the workbook and leave it open for a later exercise. 

Using the Insert Function  

You can enter a function into a cell just as you would enter any formula: by 

typing it directly in the cell or in the Formula bar. The Insert Function button 

offers a third option. By accepting arguments and even additional functions, the 

Function Arguments dialog box helps you create formulas that contain 

functions. In fact, the Function Arguments dialog box is particularly useful 

when a formula contains more than one function, such as a function within a 

function. The Insert Function dialog box lists each function. The Function 

Arguments dialog box lists each function’s arguments, a description of each 

function and its arguments, the calculated result of each function, and the 

overall formula. 

At Adventure Works, the accountant uses the Insert Function feature to 

calculate the annual income generated through the rental of various types of 

sporting equipment. 

In this exercise, you use the Insert Function feature to enter functions in a 

worksheet. 

1 Open the Activity Rentals workbook from the Part IV, Lesson03 

folder in the Computer Fundamentals Practice folder. 

2 Click cell O3, and press Delete. 

The formula is deleted from the cell. 

3 Click the Insert Function button to the left of the Formula bar. 

The Insert Function dialog box opens, as shown in the illustration 

on the following page. 
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4 In the Select a function list, click SUM and then click OK. 

The Function Arguments dialog box appears, showing the SUM 

function totaling cells C3:N3. 

 

5 In the Formula bar, click to the right of the closing parenthesis, and 

type *A3. 

This formula totals the number of kayak rentals per year, and then it 

multiplies the total by the cost per rental. 

6 Click OK in the Function Arguments dialog box. 

The Function Arguments dialog box closes and the result of the 

income calculation (1995) appears in cell O3. 

7 Click cell A20. Then type =COUNT( and select cells A3:A17. 

Cells A3 through A17 appear as arguments in the COUNT function. 

8 Type the closing ) and press Enter. 

Excel counts 15 numeric entries in cells 3 through 17 of column A. 

9 Delete the entry in cell A20, and save the workbook. Leave the 

workbook open for a later lesson. 
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Using Date Functions 

Excel’s Date and Time functions allow you to use dates and times in formulas. 

To perform calculations on these values, Excel converts each date and time to a 

serial number. The Date function performs that conversion for any year, month, 

and day combination you enter. The Time function converts any hour, minute, 

and second combination you enter. 

NOW and TODAY are two of the most frequently used date functions. NOW 

returns the date and time that the function was entered in a worksheet. TODAY 

returns only the date. Each time you open a workbook that uses one of these 

functions, the date or time is updated automatically. 

In March, the reservations manager needs to figure the occupancy rate for the 

winter season, which runs from November 1 through the end of February. He 

wants to confirm the number of days in that season. 

In this exercise, you use Date functions to calculate the amount of time between 

two dates. 

1 Switch to the Lodging Usage workbook. 

2 Click cell A20, and click the Insert Function button. 

3 Select DATE from the Select a function list and click OK. 

The Function Arguments dialog box opens. 

4 In the Year box, type 2004. 

5 In the Month box, type 02. 

6 In the Day box, type 29. 

The serial number for the date 02/29/2004 appears as the formula 

result at the bottom of the Function Arguments dialog box. 

 

7 Click to the right of the function in the Formula bar, and type a 

minus sign (-). 

8 On the Functions list to the left of the Formula bar, click Date. 

The Function Arguments dialog box opens. 
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9 In the Year, Month, and Day boxes, type the date 11/01/2003, and 

click OK. 

The total number of days (120) between 11/1/2003 and 2/29/2004 

appears in the cell. The formula reads: 

 =DATE(2000,2,29) -DATE(1999,11,1) 

10 In the Formula bar, click the first Date function. 

A ScreenTip appears with a description of each item in that portion 

of the formula. 

11 Click year in the ScreenTip to select the current number and type 

2005. 

12  In the Formula bar, click to the right of the formula. 

13 Press the Backspace key 15 times to remove the second date 

function. 

14 Type TODAY(), and press Enter. 

The total number of days between 2/29/2005 and the current date 

appears in the cell. 

15 Close the workbook without saving your changes. 

tip 

To quickly calculate the number of days between two dates that already 

appear in cells in your worksheet, simply subtract one cell from the other. 

For example, if cell A1 contains the date 11/1/2003 and cell A2 contains the 

date 2/29/2004, the number of days between them can be calculated with 

the following formula. 

 =A2-A1 

Make sure to choose the number format for the cell containing this formula. 

Otherwise, Excel displays the result in the same format as the cells used in 

the calculation (in this case, as a date). 

Using Absolute and Relative Cell 
References 

In Excel, you can refer to other cells either absolutely or relatively. An 

absolute reference refers to the address of a specific cell. A relative reference 

refers to a cell that is a specific number of rows and columns from the cell that 

contains the reference. 

Date functions are most 

useful when the date 

arguments are formulas, 

rather than constants. 
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Cell references are frequently used in formulas. By default, cell references are 

relative, even if the formula contains the row letter and column number of the 

target cell. For example, if you enter 

 =SUM(C4,C5) 

in cell C6, the resulting value in C6 will be C4 + C5. If you copy this formula 

to cell D6, the formula in D6 will appear as 

 =SUM(D4,D5) 

and the resulting value in cell D6 will be D4 + D5. Excel automatically adjusts 

the cell references relative to their new location; that’s why they are called 

“relative” cell references. 

In some cases, however, you need cell references that won’t change when you 

copy them from one location to another. For example, a formula might refer to 

a cell with a rate of interest that is always stored in a particular cell. It’s also 

possible for a cell reference to have an absolute reference to a row but not to a 

column, and vice versa. To make a cell reference absolute, type a dollar sign 

($) before either or both of the column or row references. 

For example, $C$1 is an absolute reference to cell C1. $C1 is an absolute 

reference to column C, but the reference to row 1 is relative. C$1 is a relative 

reference to column C, but the reference to row 1 is absolute. 

tip 

Using 3-D references, you can link to cells in other worksheets or 

workbooks. This type of reference  can also be absolute or relative. 

At Adventure Works, the reservations manager is having trouble copying the 

formulas in his worksheet that calculate simple averages. Using a combination 

of absolute and relative references, however, he is able to easily replicate the 

formulas to compute the necessary averages. 

In this exercise, you use absolute references and relative references to build and 

copy a formula. 

1 Open the Lodging Usage workbook with which you worked earlier 

in this lesson. 

2 Double-click cell C13. 

3 Type a dollar sign ($) before the A in the reference to cell A5, and 

press Enter. 

The formula reads =C5/$A5. 

4 Copy the formula in cell C13 to cell D13, and click cell D13 if 

necessary to select it. 
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The formula in cell D13 reads =D5/$A5. Because the column 

reference to cell A5 is absolute, that reference does not change 

when the formula is copied. The reference to the first cell in the 

formula is entirely relative. 

5 Copy the formula in cell C13 to cell C14, and click cell C14. 

The formula in cell C14 reads =C6/$A6. Because the reference to 

column A is absolute, that reference does not change when the 

formula is copied. However, the row reference is still relative, so 

that value is updated when the formula is copied. The reference to 

the first cell is entirely relative. 

6 Using Fill handles, copy the formula to complete the Average 

Number of Nights Occupied Per Room table (C13:N16). 

 

7 Save and close the workbook. 

Using Basic Statistical Functions 

Excel offers hundreds of functions, many of which are very specific to certain 

tasks or to people in certain occupations. Most people find that there are a 

couple of functions that they use all of the time and many that they will never 

have reason to use. Excel’s basic and most frequently used functions are shown 

in the following table. 

Function Meaning Example 

Sum Totals the numeric arguments. =SUM(B5:B10) 

Average Computes the average 

(arithmetic mean) of the 

numeric arguments. 

=AVERAGE(B5:B10

) 

Count Within the argument list, 

counts only the cells that 

contain numbers. 

=COUNT(B5:B10) 

Min Returns the smallest number 

within the arguments. 

=MIN(B5:B10) 

Max Returns the largest number 

within the arguments. 

=MAX(B5:B10) 

The activities manager at Adventure Works is learning which Excel functions 

might help her devise a strategy for activities in the next year. 

In this exercise, you create formulas using the AVERAGE, MIN, and MAX 

functions. 
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1 In the Activity Rentals workbook, click cell A20, if necessary, and 

click the Insert Function button. 

2 Click AVERAGE in the Select a function list and then click OK. 

3 In the Number 1 box, click the Collapse Dialog button. 

The Function Arguments dialog box collapses, allowing you to 

select the range of cells to be averaged. 

4 Select cells C15:N15, and click the Expand Dialog button in the 

Function Arguments dialog box. 

The Function Arguments dialog box appears with the completed 

AVERAGE function. 

 

5 In the Function Arguments dialog box, click OK. 

The average number of pairs of binoculars rented per month (16) 

appears in cell A20. 

6 Click in the Formula bar and select the word AVERAGE. 

7 Click the Functions down arrow to the left of the Formula bar 

(currently displaying the text AVERAGE), and click MAX. 

The Function Arguments dialog box opens with the range 

previously used already entered. 

 

tip  

If you forget the syntax for a function you want to use, type = and the name 

of the function in a cell, and then press Ctrl+A. The Function Arguments 

dialog box appears so you can enter the arguments for your function. 
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8 In the Function Arguments dialog box, click OK. 

The highest number of pairs of binoculars rented in a month (25) 

appears in cell A22. 

9 Click cell A24, type =MIN(C15:N15), and then press Enter. 

The lowest number of pairs of binoculars rented in a month (9) 

appears in cell A24. 

10 Delete the entries in cells A20 and A24. 

Keep this file open for the next exercise. 

Using Numbered Series and AutoFill 

When you enter data that forms a series or pattern, Excel can save you time by 

completing the series for you. 

If you’re entering sequential numbers, the days of a week, the months in a year, 

or another series, you don’t have to type each item in the series. Just type the 

first one or two entries, and use AutoFill to finish the series for you. 

For example, if you want to enter days of the week in a worksheet, type 

Monday (or whichever day you want to start with), and then use AutoFill to 

enter the rest of the days. If you want to enter every other day in a worksheet, 

type Monday in the first cell, Wednesday in the second cell, and then use 

AutoFill to finish the series. 

A new feature in the current version of Excel is the Auto Fill Options button 

that appears next to data you add to a worksheet using either AutoFill or 

FillSeries. Much like the Paste Options button, clicking the Auto Fill Options 

button displays a list of actions Excel can take regarding the cells affected by 

your Fill operation. This table summarizes the options in the list: 

Option Action 

Copy Cells Copy the contents of the selected cells to the cells 

indicated by the Fill operation. 

Fill Series Fill the cells indicated by the Fill operation with 

the next items in the series. 

Fill Formatting Only Copy the format of the selected cell to the cells 

indicated by the Fill operation, but do not place 

any values in the target cells. 

Fill Without Formatting Fill the cells indicated by the Fill operation with 

the next items in the series, but ignore any 

formatting applied to the source cells. 

Fill <sequence> This option changes according to the series Excel 

detects and seems to have the same effect as the 

Fill Series option. If you do not use a recognized 

sequence, the option does not appear. 
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tip 

If the Auto Fill Options button doesn’t appear, you can turn the feature on 

by clicking Options on the Tools menu. In the dialog box that appears, click 

the Edit tab and then select the Show Paste Options buttons check box. 

In this exercise, you use AutoFill to fill cells in a worksheet. 

1 In the Activity Rentals workbook, click the Sheet2 sheet tab. 

2 Click cell B1, type January, and then press Enter. 

3 Select cells B1:M1. 

4 On the Edit menu, point to Fill, and click Series. 

The Series dialog box appears. 

 

5 In the Type section, click the AutoFill option, and click OK. 

The months of the year fill row 1. 

6 Click cell A2, type 1st, and then press Enter. 

7 The insertion point moves to cell A3. 

8 Type 3rd, and press Enter. 

9 Select the range A2:A3, and drag the Fill handle down to cell A17. 

Odd numbered days fill the column. 

tip 

Excel includes another timesaving feature called AutoComplete. 

AutoComplete can finish text entries for you when you type in a column. If 

the first few letters that you type match a previous entry in the column, 

Excel completes the entry. You can disable AutoComplete by clicking 

Options on the Tools menu, clicking the Edit tab, and clearing the Enable 

AutoComplete For Cell Values check box. 
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Lesson Wrap-Up 

In this lesson, you learned how to create, copy, and edit formulas. You also 

learned how to use AutoSum, the Insert function, Date functions, basic 

Statistical functions, and absolute and relative cell references. Finally, you 

learned how to use AutoFill when working with numbered series. 

If you are continuing to other lessons: 

■ Close the Activity Rentals workbook and save your changes. 

If you are not continuing to other lessons: 

1 Close the Activity Rentals workbook and save your changes. 

2 Click the Close button in the top-right corner of the Excel window. 

Quick Quiz 

1 How can you enter a formula into a cell? 

2 What is the quickest way to total a column of values? 

3 How can you copy a formula to a range of adjacent cells? 

4 What are two ways to edit a formula in a cell? 

Putting It All Together 

Exercise 1: Open the Lodging Usage workbook, and copy the formula in cell 

O5 to cells O6:O9. Then complete the row of totals in the next table, and create 

a formula to compute the average number of nights occupied in each room type 

for the year. Finally, compute the occupancy rates, and figure the average 

occupancy rate of each room type for the year. 

Exercise 2: Open the Activity Rentals workbook, and complete the table on 

the Monthly Rentals worksheet. Calculate the total number of rentals each 

month, the annual income for each type of equipment, and the total annual 

income. Use the NOW function to display the current date and time in cell A1. 

On Sheet2, use AutoFill to replace the list of odd-numbered days with a list of 

years beginning with 2000 and ending in 2015. 
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Exercise 3: In this lesson we typed in the COUNT function. Can this function 

be entered through the Insert Function dialog box? If so, what category of 

functions does it belong to? Review the other categories available from the 

Insert Function dialog box. What category would you be likely to use the most? 

Exercise 4: In this lesson we illustrated how to find the number of days 

between two days by entering the dates in a formula that subtracted one date 

from the other. Is there a function that can do this automatically? Is there a way 

to calculate just the number of workdays between two dates (not counting 

weekends)? Explore the Date & Time category of the Insert Function dialog 

box or use Excel’s Help files to find the answers to these questions and write a 

brief summary of your findings. 

Exercise 5: In this lesson we touched briefly on the new Auto Fill Options 

button that appears whenever you fill cells. Return to the Activity Rentals 

workbook and repeat the AutoFill and Series steps but this time explore using 

the options available through the Auto Fill Options button. Briefly describe 

how these options could be useful. 


